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Paper Set 1 · 30 May 2026 · 4:00 PM - 5:30 PM · OSSSC CRE 2025 (Odia)

Quant

✓

Q1 Quant
ସଂଖ୍ୟା 40, 60, 32, 70 ଓ 26 ର ଭାର ଯଥାକ୍ର ମେ 1, 2, 3, 4 ଓ 5 ଅଟେ । ଭାରି ତ
ମାଧ୍ୟମାନ କେତେ?

A.  44.2

B.  44.8

C.  44.6

D.  44.4

✓

Q2 Quant
ଯଦି  8 ଟି  ପେନସି ଲର ମୂ ଲ୍ୟ ₹24 ହୁ ଏ, ତେବେ 14 ଟି  ପେନସି ଲର ମୂ ଲ୍ୟ ନି ର୍ଣ୍ଣ ୟ କର ।

A.  ₹39

B.  ₹42

C.  ₹45

D.  ₹48

✓

Q3 Quant
P ଓ Q ଏକ ବ୍ୟବସାୟ ଆରମ୍ଭ କରନ୍ତି  । P ନି ବେଶ କରି ଥି ବା ରାଶି  ₹25,000 ଏବଂ Q
ନି ବେଶ କରି ଥି ବା ରାଶି  ₹40,000 ଅଟେ । 3 ମାସ ପରେ P ଅତି ରି କ୍ତ ₹15,000 ନି ବେଶ
କରନ୍ତି  । ଯଦି  ବର୍ଷ  ଶେଷରେ ମୋଟ ଲାଭ ₹1,22,000 ହୁ ଏ, ତେବେ ଲାଭରେ Q ଙ୍କ ଅଂଶ
କେତେ?

A.  ₹64,000

B.  ₹60,000

C.  ₹68,000

D.  ₹58,000

✓

Q4 Quant
ଜଣେ ବ୍ୟବସାୟୀ 15% କ୍ଷତି ରେ ଏକ ଜି ନି ଷ ବି କ୍ରି   କରନ୍ତି  । ଯଦି  ବି କ୍ର ୟ ମୂ ଲ୍ୟ ₹850 ହୁ ଏ,
ତେବେ କ୍ର ୟ ମୂ ଲ୍ୟ ନି ର୍ଣ୍ଣ ୟ କର ।

A.  ₹1,000

B.  ₹1,200

C.  ₹1,500

D.  ₹2,000

✓

Q5 Quant
ପାଇପ A ଓ B ଗୋଟି ଏ ଖାଲି  ଟାଙ୍କି କୁ  24 ମି ନି ଟରେ ପୂ ର୍ଣ୍ଣ  କରି ପାରି ବେ । କେବଳ ପାଇପ A
ଟାଙ୍କି କୁ  ପୂ ର୍ଣ୍ଣ  କରି ବା ପାଇଁ  40 ମି ନି ଟ ସମୟ ନି ଏ । କେବଳ ପାଇପ B ଟାଙ୍କି କୁ  ପୂ ର୍ଣ୍ଣ  କରି ବା
ପାଇଁ  କେତେ ସମୟ (ମି ନି ଟ ରେ) ନେଇଥାଏ?

A.  50

B.  54

C.  56

D.  60

✓

Q6 Quant
ଜଣେ ନି ବେଶକ ପ୍ର ତ୍ୟେକ ₹20 ମୂ ଲ୍ୟର Stock A ର 40 ଟି  ସେୟାର ଏବଂ ପ୍ର ତ୍ୟେକ ₹40
ମୂ ଲ୍ୟର Stock B ର 60 ଟି  ସେୟାର ଧାରଣ କରି ଛନ୍ତି  । ତେବେ ଉକ୍ତ ନି ବେଶକଙ୍କ
ପୋର୍ଟ ଫୋଲି ଓରେ (Portfolio) ସେୟାର ପି ଛା ହାରାହାରି  ମୂ ଲ୍ୟ କେତେ?

A.  ₹ 32

B.  ₹ 34

C.  ₹ 30

D.  ₹ 40

✓

Q7 Quant
ଗୋଟି ଏ ସାର୍ଟ ର ମୂ ଲ୍ୟ 20% ବୃ ଦ୍ଧି  ପାଏ ଏବଂ ତା’ପରେ 10% ହ୍ରା ସ ପାଏ । ମୂ ଲ୍ୟରେ
ପରି ବର୍ତ୍ତ ନ ପ୍ର ତି ଶତ କେତେ?

A.  10% ବୃ ଦ୍ଧି

B.  2% ହ୍ରା ସ

C.  8% ବୃ ଦ୍ଧି

D.  କୌଣସି  ପରି ବର୍ତ୍ତ ନ ନାହିଁ 

✓

Q8 Quant
ସଂଖ୍ୟା 6, 9, 12 ଓ x ସମାନୁ ପାତରେ ଅଛନ୍ତି  । ଯଦି  (x + 2), (x + 12), 18 ଓ k
ସମାନୁ ପାତରେ ଅଛନ୍ତି , ତେବେ k ର ମୂ ଲ୍ୟ ନି ର୍ଣ୍ଣ ୟ କର ।

A.  20

B.  24

C.  27

D.  36
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✓

Q9 Quant

ଯଦି  ଏକ ସମଘନର ଆୟତନ 27000 m3 ହୁ ଏ, ତେବେ ଏହାର ପାର୍ଶ୍ୱ ପୃ ଷ୍ଠର କ୍ଷେତ୍ର ଫଳ

(m2 ରେ) ନି ର୍ଣ୍ଣ ୟ କର ।

A.  3600

B.  3590

C.  3605

D.  5400

✓

Q10 Quant
ଜଣେ ଅଧି କାରୀଙ୍କ ବର୍ତ୍ତ ମାନର ଦରମା ₹14,500 ଅଟେ । ପ୍ର ଥମ ବର୍ଷ ରେ ଏହା 10% ବୃ ଦ୍ଧି
ପାଇଥି ଲା, ଦ୍ୱି ତୀୟ ବର୍ଷ ରେ 20% ହ୍ରା ସ ପାଇଥି ଲା ଏବଂ ତୃ ତୀୟ ବର୍ଷ ରେ 34% ବୃ ଦ୍ଧି
ପାଇଥି ଲା । ତୃ ତୀୟ ବର୍ଷ  ଶେଷରେ ତାଙ୍କର ଦରମା କେତେ ଥି ଲା?

A.  ₹17,068.40

B.  ₹17,078.40

C.  ₹17,088.40

D.  ₹17,098.40

✓

Q11 Quant
ଜଣେ ଦୋକାନୀ ଏକ ସାମଗ୍ରୀ ର ଚି ହ୍ନି ତ ମୂ ଲ୍ୟକୁ  ଏହାର କ୍ର ୟ ମୂ ଲ୍ୟ ଠାରୁ  50% ଅଧି କ ସ୍ଥି ର
କରନ୍ତି  । 5% ଲାଭ ପାଇବା ପାଇଁ  ଚି ହ୍ନି ତ ମୂ ଲ୍ୟ ଉପରେ କେତେ ପ୍ର ତି ଶତ ରି ହାତି  ଦି ଆଯି ବା
ଉଚି ତ?

A.  30%

B.  33%

C.  31%

D.  29%

✓

Q12 Quant

36° କେନ୍ଦ୍ରସ୍ଥ କୋଣ ବି ଶି ଷ୍ଟ ଏକ ବୃ ତ୍ତଖଣ୍ଡର କ୍ଷେତ୍ର ଫଳ 32.4 π cm2 ହେଲେ, ସେହି
ବୃ ତ୍ତର ବ୍ୟାସ (cm ରେ) କେତେ?

A.  18

B.  28

C.  36

D.  42

✓

Q13 Quant
A(1, 3), B(4, 7) ଏବଂ C(6, 9) ବି ନ୍ଦୁ ଗୁ ଡି କ ଦ୍ୱାରା ଗଠି ତ ତ୍ରି  ଭୁ ଜର ପ୍ର କାର ନି ର୍ଣ୍ଣ ୟ କରନ୍ତୁ ।

A.  ସମବାହୁ  ତ୍ରି  ଭୁ ଜ

B.  ବି ଷମବାହୁ  ତ୍ରି  ଭୁ ଜ

C.  ସାମଦ୍ଵି ବାହୁ  ତ୍ରି  ଭୁ ଜ

D.  ସମକୋଣୀ ତ୍ରି  ଭୁ ଜ

✓

Q14 Quant
ରଜତ ପଏଣ୍ଟ A ରୁ  ପଏଣ୍ଟ B କୁ  28 km/hr ବେଗରେ ଯାତ୍ରା  କରେ ଏବଂ ପଏଣ୍ଟ B ରୁ
ପଏଣ୍ଟ A କୁ  44 km/hr ବେଗରେ ଫେରି ଆସେ । ସମଗ୍ର  ଯାତ୍ରା  ପାଇଁ  ହାରାହାରି  ବେଗ
ନି ର୍ଣ୍ଣ ୟ କର । (ପ୍ରା ୟ ଦଶମି କ ଦୁ ଇ ସ୍ଥାନ ପର୍ଯ୍ୟ ନ୍ତ)

A.  34.22 km/hr

B.  34.76 km/hr

C.  34.92 km/hr

D.  34.06 km/hr

✓

Q15 Quant
ପାଇପ A ଏକ ଟାଙ୍କି କୁ  5 ଘଣ୍ଟାରେ, ପାଇପ B ସେହି  ଟାଙ୍କି କୁ  30 ଘଣ୍ଟାରେ ଏବଂ ପାଇପ C
ସେହି  ଟାଙ୍କି କୁ  60 ଘଣ୍ଟାରେ ପୂ ର୍ଣ୍ଣ  କରେ । ଯଦି  ତି ନୋଟି ଯାକ ପାଇପ ଏକାଠି  ଖୋଲାଯାଏ,
ତେବେ ଟାଙ୍କି ର ଅଧା ଅଂଶ ପୂ ର୍ଣ୍ଣ  ହେବା ପାଇଁ  କେତେ ଘଣ୍ଟା ସମୟ ଲାଗି ବ?

A.  2

B.  3

C.  4

D.  5

✓

Q16 Quant
ରାଜୁ  2 ବର୍ଷ  ପାଇଁ  ବାର୍ଷିକ 24% ଚକ୍ର ବୃ ଦ୍ଧି  ସୁ ଧ ହାରରେ ₹8,000 ଏବଂ ବାର୍ଷିକ 24%
ସରଳ ସୁ ଧ ହାରରେ ₹10,000 ନି ବେଶ କଲେ । ଯଦି  ସେ ଏହାର ପରି ବର୍ତ୍ତେ  ସମାନ ଅବଧି
ପାଇଁ  ବାର୍ଷିକ 24% ଚକ୍ର ବୃ ଦ୍ଧି  ସୁ ଧ ହାରରେ ₹10,000 ଏବଂ ବାର୍ଷିକ 24% ସରଳ ସୁ ଧ
ହାରରେ ₹8,000 ନି ବେଶ କରନ୍ତି , ତେବେ ତାଙ୍କ ନି ବେଶ ପ୍ର ଣାଳୀରେ ପରି ବର୍ତ୍ତ ନ କରି ବା
ଦ୍ୱାରା ସେ କେତେ ଅତି ରି କ୍ତ ଟଙ୍କା ଲାଭ କରି ବେ?

A.  ₹115.20

B.  ₹112.20

C.  ₹125.20

D.  ₹113.20

✓

Q17 Quant
ଏକ ଟ୍ୟାକ୍ସି  ଷ୍ଟାଣ୍ଡରୁ  ଦୁ ଇଟି  କ୍ୟାବ 34 ମି ନି ଟ ବ୍ୟବଧାନରେ 54 km/hr ବେଗରେ ଯାତ୍ରା
ଆରମ୍ଭ କରନ୍ତି , ଉଭୟ କ୍ୟାବ ସମାନ ଦି ଗରେ ଯାତ୍ରା  କରନ୍ତି  । ଟ୍ୟାକ୍ସି  ଷ୍ଟାଣ୍ଡ ଆଡକୁ  ବି ପରୀତ
ଦି ଗରୁ  ଆସୁ ଥି ବା ଜଣେ ବ୍ୟକ୍ତି  30 ମି ନି ଟ ବ୍ୟବଧାନରେ କ୍ୟାବଗୁ ଡ଼ି କୁ  ଭେଟି ଥାନ୍ତି  । ବ୍ୟକ୍ତି ଙ୍କ
ବେଗ (km/hr ରେ) ନି ର୍ଣ୍ଣ ୟ କର ।

A.  7.2

B.  17.1

C.  6.6

D.  5.4
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✓

Q18 Quant
ନି ମ୍ନ ଲି ଖି ତକୁ  ସରଳ କରି  ଭଗ୍ନାଂଶ ରେ ପ୍ର କାଶ କର ।

A.  

B.  

C.  

D.  

✓

Q19 Quant

ସମୀକରଣ  ର ମୂ ଳ ଦ୍ୱୟର ସମଷ୍ଟି  ନି ର୍ଣ୍ଣ ୟ କର ।

A.  2

B.  3

C.  −3

D.  −6

✓

Q20 Quant

 ସରଳ କର ।

A.  288

B.  7776

C.  1152

D.  2304
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GA

✓

Q21 GA
ଦୁ ଇଟି  ପ୍ର ତି ରୋଧକ, R₁ ଏବଂ R₂, ପଂକ୍ତି  (series)ରେ ସଂଯୁ କ୍ତ ହୋଇଛି  ଯଦି  ଏଥି ରେ R₁ =
4 Ω ଏବଂ R₂ = 6 Ω, ଏବଂ 20 V ର ଏକ ଭୋଲଟେଜ୍  ପ୍ର ୟୋଗ କରାଯାଏ, ତେବେ R₂
ମଧ୍ୟରେ ଭୋଲଟେଜ୍  ଡ୍ର ପ୍  କେତେ ହେବ?

A.  4 V

B.  6 V

C.  8 V

D.  12 V

✓

Q22 GA
N₂ ଏବଂ H₂ ରୁ  ଆମୋନି ଆ (NH₃) ଗଠନ ଏକ ________ ଅଟେ ।

A.  ବି ଜାରଣ ଜାରଣ ପ୍ର ତି କ୍ରି  ୟା

B.  ବି ସ୍ଥାପନ

C.  ବି ଘଟନ

D.  ସଂଶ୍ଳେଷଣ

✓

Q23 GA
ଓଡ଼ି ଶାର ନି ମ୍ନ ଲି ଖି ତ ଶି ଳ୍ପାଞ୍ଚଳଗୁ ଡ଼ି କ ମଧ୍ୟରୁ  କେଉଁ ଠାରେ ଆଲୁ ମି ନି ୟମ ଏବଂ ରୋଲିଂ  ମି ଲ
ମୁ ଖ୍ୟତଃ ଅଧି କ ଅଛି ?

A.  ହୀରାକୁ ଦ

B.  ତାଲଚେର-ଅନୁ ଗୁ ଳ

C.  ରାୟଗଡା

D.  ଚୌଦ୍ୱାର

✓

Q24 GA
ଅହମ୍ମଦାବାଦ ଠାରେ ଅନୁ ଷ୍ଠି ତ କମନୱେଲଥ ୱେଟଲି ଫଟି ଙ୍ଗ ଚାମ୍ପି ଅନସି ପ
(Commonwealth Weightlifting Championships) 2025 ରେ କେଉଁ
ଭାରତୀୟ ଭାରଉତ୍ତୋଳନକାରୀ ସ୍ଵର୍ଣ୍ଣ  ପଦକ ଜି ତି ବା ସହ ନୂ ତନ ଜାତୀୟ ରେକର୍ଡ  ସ୍ଥାପନ
କରି ଛନ୍ତି ?

A.  ମୀରାବାଇ ଚାନୁ

B.  ହର୍ଷ ଦ ଗରୁ ଡ଼

C.  ପୁ ନମ ଯାଦବ

D.  ବି ନ୍ଦ୍ୟାରାଣୀ ଦେବୀ

✓

Q25 GA
ଉପଦ୍ୱୀପ ମାଳଭୂ ମି ର ପଶ୍ଚି ମ ଏବଂ ଉତ୍ତର-ପଶ୍ଚି ମ ସୀମାରେ ନି ମ୍ନ ଲି ଖି ତ କେଉଁ  ପର୍ବ ତମାଳା
ଅବସ୍ଥି ତ?

A.  ଆରାବଳୀ ପର୍ବ ତମାଳା

B.  ଅନାଇ ମୁ ଡି  ପର୍ବ ତମାଳା

C.  ଶେବରୋୟ ପର୍ବ ତମାଳା

D.  ଗାରୋ ପର୍ବ ତମାଳା

✓

Q26 GA
1936 ରେ ଗଠି ତ ଓଡ଼ି ଶା ବି ଧାନସଭା କେଉଁ  ପ୍ର କାରର ବୈ ଧାନି କ ସଂସ୍ଥା ଥି ଲା?

A.  ଦ୍ୱି ସଦନୀୟ ସଂସ୍ଥା

B.  ଏକସଦନୀୟ ସଂସ୍ଥା

C.  ସ୍ୱାଧୀନ ସଂସ୍ଥା

D.  ଅର୍ଦ୍ଧ -ସଙ୍ଘୀୟ ସଂସ୍ଥା

✓

Q27 GA
2025 ମସି ହା ଜୁ ଲାଇ ମାସରେ ଚେନ୍ନାଇରେ ଅନୁ ଷ୍ଠି ତ ଇଣ୍ଡି ଆ ଇଣ୍ଟରନ୍ୟାସନାଲ ଟ୍ରା ଭେଲ
ମାର୍ଟ  (IITM)ରେ କେଉଁ  ଅଭି ଯାନ ପାଇଁ  ଓଡ଼ି ଶା 'ରେସ୍ପନ୍ସି  ବଲ ଟୁ ରି ଜି ମ ଇନି ସି ଏଟି ଭ ଅଫ ଦି
ଇୟର' ପୁ ରସ୍କାର ଲାଭ କରି ଥି ଲା?

A.  ସ୍ଥାୟୀ ପର୍ଯ୍ୟ ଟନର ପ୍ରୋ ତ୍ସାହନ

B.  ତଟବର୍ତ୍ତୀ  ପର୍ଯ୍ୟ ଟନ ସର୍କିଟ ବି କାଶ

C.  ଆଦି ବାସୀ ପର୍ଯ୍ୟ ଟନ ଯୋଜନା

D.  ଡି ଜି ଟାଲ ଏକ୍ସପ୍ଲୋ ର ଓଡ଼ି ଶାର ଶୁ ଭାରମ୍ଭ

✓

Q28 GA
କି ଏ 2025 ପାଇଁ  ଶ୍ରେ ଷ୍ଠ FIFA ପୁ ରୁ ଷ ପ୍ର ଶି କ୍ଷକ ପୁ ରସ୍କାର ଜି ତି ଛନ୍ତି ?

A.  ଲୁ ଇସ ଏନରି କ (Luis Enrique)

B.  ପେପ ଗାର୍ଡିଓଲା (Pep Guardiola)

C.  କାର୍ଲୋ  ଆନସେଲୋଟି  (Carlo Ancelotti)

D.  ସାରି ନା ୱି ଗମ୍ୟାନ (Sarina Wiegman)

✓

Q29 GA
ସେପ୍ଟେମ୍ବର 2025 ରେ DRDO କେଉଁ  କମାଣ୍ଡର ସହଯୋଗରେ 'ଅଗ୍ନି -ପ୍ରା ଇମ' କ୍ଷେପଣାସ୍ତ୍ରର
ସଫଳ ପରୀକ୍ଷଣ କରି ଥି ଲା?

A.  ଡି ଫେନ୍ସ  ସାଇବର ଏଜେନ୍ସି

B.  ଷ୍ଟ୍ରାଟେଜି କ ଫୋର୍ସେ ସ କମାଣ୍ଡ

C.  ଆଣ୍ଡାମାନ ଏବଂ ନି କୋବର କମାଣ୍ଡ

D.  ଇଣ୍ଡି ଆନ ନାଭି  ମି ଶାଇଲ ୱି ଙ୍ଗ

✓

Q30 GA
ଓଡ଼ି ଶା ସରକାରଙ୍କ 'ଆମ ସାଥୀ' ୟୁ ନି ଫାଇଡ ହ୍ଵାଟ୍ସ ଆପ ବଟ (WhatsApp BOT) 2026
ମସି ହା ଫେବୃ ଆରୀ ମାସରେ କେଉଁ  ସ୍ଵୀକୃ ତି  ଲାଭ କରି ଥି ଲା?

A.  ଟେକ୍ନୋ ଲୋଜି  ସଭା ଏକ୍ସି ଲେନ୍ସ  ଆୱାର୍ଡ  (Technology Sabha Excellence
Award)

B.  ନ୍ୟାସନାଲ ଇ-ଗଭର୍ଣ୍ଣା ନ୍ସ  ସ୍ୱର୍ଣ୍ଣ  ଆୱାର୍ଡ  (National e-Governance Gold
Award)

C.  ଡି ଜି ଟାଲ ଇଣ୍ଡି ଆ ଇନୋଭେସନ ଆୱାର୍ଡ  (Digital India Innovation
Award)

D.  ସ୍ମାର୍ଟ  ଗଭର୍ଣ୍ଣା ନ୍ସ  ପ୍ଲା ଟି ନମ ଆୱାର୍ଡ  (Smart Governance Platinum Award)
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✓

Q31 GA
ସ୍ୱାଧୀନତାର ପ୍ରା ରମ୍ଭି କ ବର୍ଷ ଗୁ ଡ଼ି କରେ (1950–1970 ଦଶକ), ଭାରତର GDP ଅଭି ବୃ ଦ୍ଧି
ହାର ଅତି  ଧୀମା ଥି ଲା, ଯାହା ପ୍ରା ୟତଃ 3% ରୁ  4% ମଧ୍ୟରେ ରହୁ ଥି ଲା । ଏହି  ନି ର୍ଦ୍ଦିଷ୍ଟ
ଅଭି ବୃ ଦ୍ଧି  ହାରକୁ  ବର୍ଣ୍ଣ ନା କରି ବା ପାଇଁ  ସାଧାରଣତଃ କେଉଁ  ପଦ ବ୍ୟବହାର କରାଯାଉଥି ଲା?

A.  ନେହେରୁ ବାଦୀ ସ୍ଥାଣୁ ତା (Nehruvian stagnation)

B.  ହି ନ୍ଦୁ  ଅଭି ବୃ ଦ୍ଧି  ହାର (Hindu rate of growth)

C.  ସମାଜବାଦୀ ଅଭି ବୃ ଦ୍ଧି  ମଡେଲ (Socialist growth model)

D.  ଉଦାରୀକରଣ-ପୂ ର୍ବ  ଚକ୍ର  (Pre-liberalization cycle)

✓

Q32 GA
ଫେବୃ ଆରୀ 2026 ରେ, ଭାରତୀୟ ନୌସେନା ଦ୍ୱାରା INS ଅଞ୍ଜଦୀପ (INS Anjadip) କୁ
ନି ମ୍ନ ଲି ଖି ତ ମଧ୍ୟରୁ  କେଉଁ  ବନ୍ଦରରେ ସାମି ଲ କରାଯାଇଥି ଲା?

A.  କୋଚି  ବନ୍ଦର

B.  ମୁ ମ୍ବାଇ ବନ୍ଦର

C.  ଚେନ୍ନାଇ ବନ୍ଦର

D.  ବି ଶାଖାପାଟନାମ ବନ୍ଦର

✓

Q33 GA
ନି ମ୍ନ ଲି ଖି ତ ସହରଗୁ ଡ଼ି କ ମଧ୍ୟରୁ  କେଉଁ ଟି  ମୂ ଳ ଦ୍ରା ଘି ମା ରେଖା ବା Prime Meridian (0°
ଦ୍ରା ଘି ମା) ର ସବୁ ଠାରୁ  ନି କଟବର୍ତ୍ତୀ ?

A.  ନ୍ୟୁ ୟର୍କ

B.  ଟୋକି ଓ

C.  ଲଣ୍ଡନ

D.  ସି ଡନୀ

✓

Q34 GA
ପ୍ରା ଚୀନ ଭାରତରେ ସଙ୍ଗମ ସାହି ତ୍ୟର ରଚନା ସହି ତ ନି ମ୍ନ ଲି ଖି ତ ଭାଷାଗୁ ଡ଼ି କ ମଧ୍ୟରୁ
କେଉଁ ଟି  ମୁ ଖ୍ୟ ଭାବେ ଜଡି ତ?

A.  ହି ନ୍ଦୀ

B.  ସଂସ୍କୃତ

C.  ପାଲି

D.  ତାମି ଲ

✓

Q35 GA
ନି ମ୍ନ ଲି ଖି ତ ଯୋଡ଼ି ଗୁ ଡ଼ି କ ମଧ୍ୟରୁ  କେଉଁ ଟି  ସଂରକ୍ଷଣ ସ୍ଥଳର ବୈ ଶି ଷ୍ଟ୍ୟପୂ ର୍ଣ୍ଣ  ପରି ସଂସ୍ଥା କି ମ୍ବା
ପ୍ର ମୁ ଖ ପ୍ର ଜାତି  ସହି ତ ସଠି କ ଭାବେ ମେଳ ହେଉ ନାହିଁ?

A.  କାଜି ରଙ୍ଗା ଜାତୀୟ ଉଦ୍ୟାନ - ଏକ ଶି ଙ୍ଘା ଗଣ୍ଡା

B.  ସୁ ନ୍ଦରବନ ଜାତୀୟ ଉଦ୍ୟାନ - କ୍ରା ନ୍ତୀୟ ଚି ରହରି ତ ବର୍ଷା  ଅରଣ୍ୟ

C.  ଗି ର ଜାତୀୟ ଉଦ୍ୟାନ - ଏସୀୟ ସିଂ ହ

D.  ଜି ମ କରବେଟ ଜାତୀୟ ଉଦ୍ୟାନ - ବ୍ୟାଘ୍ର  ଅଭୟାରଣ୍ୟ

✓

Q36 GA
କେଉଁ  ଆକ୍ଟ ଇଷ୍ଟ ଇଣ୍ଡି ଆ କମ୍ପାନୀଠାରୁ  ବ୍ରି  ଟି ଶ କ୍ରା ଉନକୁ  ଶାସନ କ୍ଷମତା ହସ୍ତାନ୍ତର କରି ଥି ଲା?

A.  ରେଗୁ ଲେଟି ଙ୍ଗ ଆକ୍ଟ, 1773

B.  ଗଭର୍ଣ୍ଣ ମେଣ୍ଟ ଅଫ ଇଣ୍ଡି ଆ ଆକ୍ଟ, 1919

C.  ଗଭର୍ଣ୍ଣ ମେଣ୍ଟ ଅଫ ଇଣ୍ଡି ଆ ଆକ୍ଟ, 1858

D.  ଗଭର୍ଣ୍ଣ ମେଣ୍ଟ ଅଫ ଇଣ୍ଡି ଆ ଆକ୍ଟ, 1935

✓

Q37 GA
ଯଦି  ଖାଦ୍ୟ ଶୃ ଙ୍ଖଳ ଉତ୍ପାଦକ ସ୍ତରରେ ବାଧାପ୍ରା ପ୍ତ ହୁ ଏ, ତେବେ ଏହାର ତତକ୍ଷଣାତ ପରି ଣାମ
କ’ଣ ହେବ?

A.  ମାଂସାଶୀ ପ୍ରା ଣୀଙ୍କ ସଂଖ୍ୟା ଦ୍ରୁ ତ ଗତି ରେ ବୃ ଦ୍ଧି  ପାଇବ

B.  ଅପଘଟକଙ୍କ ପ୍ରା ଧାନ୍ୟ ବି ସ୍ତାର ହେବ

C.  ତୃ ଣଭୋଜୀ ପ୍ରା ଣୀମାନେ ଉତ୍ପାଦକ ପାଲଟି  ଯି ବେ

D.  ଉପଭୋଗୀମାନେ ଏକ ଶକ୍ତି  ଉତ୍ସ ହରାଇବେ

✓

Q38 GA
1898 ମସି ହାରେ ଅନୁ ଷ୍ଠି ତ ଭାରତୀୟ ଜାତୀୟ କଂଗ୍ରେ ସର କେଉଁ  ଅଧି ବେଶନରେ ବ୍ରି  ଟି ଶ
ଶାସି ତ ଭାରତର ନବଗଠି ତ ପ୍ରେ ସ୍  କମି ଟି ଗୁ ଡ଼ି କ ବି ରୁ ଦ୍ଧରେ ବି ଶେଷ ପ୍ର ତି ବାଦ ପ୍ର ଦର୍ଶ ନ
କରାଯାଇଥି ଲା?

A.  11ତମ ଅଧି ବେଶନ ପୁ ନେ

B.  14 ତମ ଅଧି ବେଶନ ମାଡ୍ରା ସ

C.  15 ତମ ଅଧି ବେଶନ ଲକ୍ଷ୍ନୌ

D.  17 ତମ ଅଧି ବେଶନ କଲି କତା

✓

Q39 GA
କେଉଁ  ଶତାବ୍ଦୀରେ କଥକଳି  ନୃ ତ୍ୟ ଶୈ ଳୀ ବି କଶି ତ ହୋଇଥି ବାର ବି ଶ୍ୱାସ କରାଯାଏ?

A.  15 ତମ ଶତାବ୍ଦୀ

B.  16 ତମ ଶତାବ୍ଦୀ

C.  19 ତମ ଶତାବ୍ଦୀ

D.  18 ତମ ଶତାବ୍ଦୀ

✓

Q40 GA
ଇଣ୍ଡୋ-ଗାଙ୍ଗେୟ ସମତଳ ଭୂ ମି  ମୁ ଖ୍ୟତଃ ନି ମ୍ନ ଲି ଖି ତ କେଉଁ  ପ୍ର କ୍ରି  ୟା ଦ୍ୱାରା ଗଠି ତ?

A.  ପଟୁ  ଜମା ହେବା

B.  ଜ୍ଵାଳାମୁ ଖୀ ଉଦଗି ରଣ

C.  ହି ମଚଳନ

D.  ଟେକ୍ଟୋନି କ୍  ଉତ୍ଥାନ
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English

✓

Q41 English
Select the most appropriate article to fill in the blank. If no article is needed, select ‘No article required’.

She requested me to buy ______ box of matches from the market.

A.  the

B.  a

C.  an

D.  No article required

✓

Q42 English
Select the most appropriate option that rectifies the INCORRECTLY spelt words in the given sentence.

She explained the thieory of quantum Physiqs in a simple manner.

A.  thewery, Physiques

B.  theiroy, Physics

C.  theory, Physics

D.  thiory, Phycis

✓

Q43 English
Select the most appropriate idiom that can substitute the underlined segment in the given sentence.

The company was planning something in secret to surprise their employees on the annual day.

A.  to let the cat out of the bag

B.  to do a thing under the rose

C.  to spill the beans

D.  to call it a day

✓

Q44 English
Choose the correct form of present tense of the verb given in the bracket to complete the given sentence.

The data __________ (reveal) that the family prioritises essential expenses over miscellaneous items.

A.  reveals

B.  was revealed

C.  is revealing

D.  has been revealing
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✓

Q45 English

Read the passage and choose the correct answer to the questions based on it.

Jaisalmer, often called the "Golden City," is a stunning desert town located in the heart of the Thar Desert, Rajasthan. Its distinctive nickname
comes from the yellow sandstone used in its architecture, which glows like gold at sunset. The centerpiece is the magnificent Jaisalmer Fort, a
UNESCO World Heritage site and one of the world's few living forts, where nearly a quarter of the old city's population still resides. Constructed in
the 12th century, the fort houses intricately carved Jain temples and havelis (mansions) adorned with elaborate facades. Beyond the fort, the city
is famed for the Sam Sand Dunes, offering visitors an authentic experience of the desert landscape through camel safaris and traditional folk
performances. Jaisalmer's isolation has helped preserve its unique medieval charm and rich cultural heritage, making it a compelling study in
desert resilience, trade history, and architectural brilliance.

Which of the following would be the most precise title for the passage?

A.  The History of Fort Construction in Rajasthan

B.  Jaisalmer: Heritage in the Thar Desert

C.  The Wonders of the Sam Sand Dunes

D.  Jain Temples and Havelis in Medieval India

✓

Q46 English
What is the predominant tone of the passage when describing Jaisalmer?

A.  Critical and analytical of its isolation

B.  Informative and appreciative of its culture

C.  Speculative and uncertain about its future

D.  Detached and purely logistical

✓

Q47 English
Which of the following facts is explicitly stated in the passage about Jaisalmer Fort?

A.  It was built in the 16th century but broke down.

B.  It is the largest fort in India and even the world.

C.  It is home to a portion of the old city's population.

D.  It is constructed primarily from marble and stone.

✓

Q48 English
What can be inferred about Jaisalmer's enduring unique character?

A.  It is primarily due to recent heavy investment in modernization.

B.  Its geographical isolation has safeguarded its historical charm.

C.  Its historical trade significance has completely faded away.

D.  The fort's current function is solely as a museum and not a residence.

✓

Q49 English
Choose the word from the passage that is an antonym for "commonplace".

A.  Magnificent

B.  Intricately

C.  Unique

D.  Compelling
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✓

Q50 English
Choose the option that correctly replaces the underlined proverb in the sentence below.
The professor concluded by saying, fools rush in where angels fear to tread.

A.  reckless people act without considering danger

B.  wisdom always avoids bold action

C.  courage is more valuable than caution

D.  bravery is the key to discovery

✓

Q51 English
In the given question, a statement divided into different segments is given. The first segment is fixed, rearrange the other segments to form a
coherent statement.

The mountain appeared distant, / rising sharply against the horizon (P) / wrapped in mist and mystery (Q) / challenging every traveller who
approached (R) / silent yet commanding (S)

A.  PQSR

B.  QSRP

C.  RSPQ

D.  SRQP

✓

Q52 English
Choose the correct indirect speech for the following:
Swathi said, “I can swim.”

A.  Swathi said that she can swim.

B.  Swathi told that she could swim.

C.  Swathi said that she could swim.

D.  Swathi said she can swam.

✓

Q53 English
Select the most appropriate antonym of the underlined word in the given sentence.

Her analysis of the poem was superficial.

A.  profound

B.  shallow

C.  brief

D.  simple

✓

Q54 English
Complete the sentence by choosing the correct option.
Global warming is a ................. issue that requires immediate international cooperation.

A.  exclusive

B.  critical

C.  determined

D.  gracious

https://play.google.com/store/apps/details?id=in.qmaths.blackbook&referrer=src%3Dosssc_cre25
https://rank.qmaths.in


✓

Q55 English
In the following question choose the word opposite in the meaning to the underlined word.
The scholar was known for his profane language during the heated debate.

A.  pious

B.  temporal

C.  worldly

D.  irreverent

✓

Q56 English
Select the option that can be used as a one-word substitute for the underlined group of words.

The rising and falling actively motion of the ocean made the boat sway gently.

A.  snoozing

B.  shrinking

C.  surging

D.  polishing

✓

Q57 English
Parts of a sentence are given below in jumbled order. Arrange the parts in the correct order to form a meaningful sentence.

A. bloomed, painting the
B. a kaleidoscope
C. landscape with
D. the vibrant flowers
E. of colours

A.  BACDE

B.  CBADE

C.  DACBE

D.  BEACD

✓

Q58 English
Select the option that can be used as a one-word substitute for the underlined group of words.

All wars change society and hence leave an imprint on literary culture that cannot be erased or forgotten.

A.  indelible

B.  inedible

C.  impressive

D.  indecisive
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✓

Q59 English
Select the option that expresses the given sentence in active voice.

The solution had been proposed by the scientist before the conference began.

A.  The scientist has proposed the solution before the conference began.

B.  The scientist proposed the solution before the conference had begun.

C.  The scientist had proposed the solution before the conference began.

D.  The scientist proposed the solution before the conference began.

✓

Q60 English
Complete the sentence with a contextually and grammatically appropriate adjective.

The ___ street was filled with laughter and music.
3635

A.  desolate

B.  remarkable

C.  instrumental

D.  bustling

Odia

✓

Q61 Odia
ନି ମ୍ନ ଲି ଖି ତ ବି କଳ୍ପଗୁ ଡ଼ି କ ମଧ୍ୟରୁ  ଦି ଆଯାଇଥି ବା ଓଡ଼ି ଆ ବାକ୍ୟର ସଠି କ୍  ଇଂରାଜୀ ଅନୁ ବାଦ ବାଛନ୍ତୁ:
ଢେଙ୍କାନାଳ ଓଡ଼ି ଶାର ଏକ ପ୍ର ସି ଦ୍ଧ ହସ୍ତତନ୍ତ କେନ୍ଦ୍ର ଅଟେ ।

A.  Dhenkanal is a famous handicraft center of Odisha.

B.  Dhenkanal is the capital city of Odisha.

C.  Dhenkanal is a hill station in North India.

D.  Dhenkanal is a temple in Andhra Pradesh.

✓

Q62 Odia
ନି ମ୍ନ ଲି ଖି ତ ବି କଳ୍ପଗୁ ଡ଼ି କ ମଧ୍ୟରୁ  ଦି ଆଯାଇଥି ବା ଓଡ଼ି ଆ ବାକ୍ୟର ସଠି କ୍  ଇଂରାଜୀ ଅନୁ ବାଦ ବାଛନ୍ତୁ:
ଟି କଟଘରଟି  ରେଳ ଷ୍ଟେସନରେ ରହି ଅଛି  ।

A.  The ticket counter is at the railway station.

B.  Ticket counter are in railway station.

C.  Ticket counters is on the station railway.

D.  The ticket counter be in the railway stations.

✓

Q63 Odia
ନି ମ୍ନ ଲି ଖି ତ ବି କଳ୍ପଗୁ ଡ଼ି କ ମଧ୍ୟରୁ  ଦି ଆଯାଇଥି ବା ଓଡ଼ି ଆ ବାକ୍ୟର ସଠି କ୍  ଇଂରାଜୀ ଅନୁ ବାଦ ବାଛନ୍ତୁ:
କୃ ତ୍ରି  ମ ବୁ ଦ୍ଧି ମତା ମନୁ ଷ୍ୟ ମସ୍ତି ଷ୍କର ଚି ନ୍ତନ ପ୍ର ଣାଳୀ ପରି  ଅନୁ କରଣ କରେ ।

A.  Artificial Intelligence imitates the thinking process of the human brain.

B.  Artificial Intelligence is a machine that replaces human brains.

C.  Artificial Intelligence can think without any data.

D.  Artificial Intelligence destroys human thoughts.
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✓

Q64 Odia

ନି ମ୍ନୋ କ୍ତ ଅନୁ ଚ୍ଛେଦକୁ  ପଢି  ପ୍ର ଶ୍ନ ଗୁ ଡି କର ଉତ୍ତର ଚୟନ କର ।

ଧର୍ମ ର ପରି ଭାଷା ଅବି ଚଳ, ଅଟଳ, ଶାଶ୍ଵତ । ଏହା ମନୁ ଷ୍ୟର ସମ୍ବେଦନାର ଜାଗରଣ। ଧର୍ମ ର ବ୍ୟାଖ୍ୟାକୁ  ଜଟି ଳ କରି ବା ପ୍ର କ୍ରି  ୟା ବି ଭି ନ୍ନ ସମୟରେ ତଥାକଥି ତ ଧର୍ମା ନ୍ଧମାନେ ହିଁ ଆରମ୍ଭ କରି ଥାନ୍ତି  ।
ଧର୍ମ ର ପରି ଭାଷା ସରଳ । ଜଣେ ଛୋଟ ପି ଲା କହି ପାରି ବ ଯେ ଅନ୍ୟକୁ  ପୀଡ଼ା ଦେବା ଅଧର୍ମ , ଅନ୍ୟର ପୀଡ଼ା ଉପଶମ ଧର୍ମ ର ପରି ଚାୟକ । ଦୁଃ ଖୀର ଦୁଃ ଖ ଅପନୋଦନ, ପଥଛାଡ଼ି  ଅପଥରେ ଘୂ ରି
ବୁ ଲୁ ଥି ବା ବ୍ୟକ୍ତି ଙ୍କୁ  ସତ୍ ‌ପଥକୁ  ଆଣି ବା ଧର୍ମ ର ସ୍ଵରୂ ପ ନୁ ହେଁ  ତ ଆଉ କ'ଣ? ପ୍ର ସି ଦ୍ଧ ଦାର୍ଶ ନି କ, ସନ୍ଥ, ଲେଖକ ଲି ଓ ଟଲଷ୍ଟୟଙ୍କ ସମ୍ପର୍କିତ ନି ମ୍ନୋ କ୍ତ ପ୍ରେ ରଣାଦାୟୀ, ଶି କ୍ଷାପ୍ର ଦ ପ୍ର ସଙ୍ଗ। ଟଲଷ୍ଟୟ ଖାଲି

ପ୍ର ସି ଦ୍ଧ ଲେଖକ ନଥି ଲେ । ତାଙ୍କଠାରେ ଅନ୍ୟ ଏକ ବି ଶେଷ ଗୁ ଣ ଥି ଲା ଯାହାକୁ  ହୁ ଏତ ଅନେକେ ଜାଣି  ନଥି ବେ। ଟଲଷ୍ଟୟ ଥି ଲେ ଜଣେ ସମ୍ବେଦନଶୀଳ ବ୍ୟକ୍ତି ତ୍ଵ । ଅନ୍ୟର ଦୁଃ ଖ ସହି  ପାରୁ ନଥି ଲେ।
ନି ଜର ସାଧ୍ୟମତେ ସାହାଯ୍ୟ କରୁ ଥି ଲେ ଦୁଃ ଖୀ, ନି ପୀଡ଼ି ତଙ୍କୁ  । ଏହି  କାରଣରୁ  ପ୍ର ତ୍ୟହ ତାଙ୍କ ଘର ସମ୍ମୁଖରେ ଭି କାରି ଙ୍କ ଲମ୍ବା ଧାଡ଼ି  ଲାଗୁ ଥି ଲା । କାହାକୁ  ବି  ନି ରାଶ କରୁ ନଥି ଲେ । କାହା କାହାରି କୁ  ଅର୍ଥ ,
ବସ୍ତ୍ର, ଏପରି କି  ପି ନ୍ଧି ଥ‌ି ବା କୋଟ୍  ମଧ୍ୟ ଦାନ ଦେଇ ଦେଉଥି ଲେ । ଖୁ ବ୍ ‌ଶୀଘ୍ର  ଏପରି  ସ୍ଥି ତି  ହେଲା ଯେତେବେଳେ କି  ତାଙ୍କ ପାଖରେ ଦାନ ଦେବାକୁ  କି ଛି  ନଥି ଲା । ସେଦି ନ ଯାଚକଙ୍କ ଧାଡ଼ି ରେ ସବା
ପଛରେ ଜଣେ ବ୍ୟକ୍ତି  ଠି ଆ ହୋଇଥାନ୍ତି  । ଦୁ ର୍ବ ଳ କାରଣରୁ  ବହୁ ତ ଆଗରୁ  ଆସି ଥି ଲେ ମଧ୍ୟ ସମ୍ମୁଖକୁ  ଆସି  ପାରି  ନଥି ଲେ- ଭି ଡ଼ କମି ବାରୁ  ସବା ପଛରେ ଟଲଷ୍ଟୟଙ୍କ ନି କଟକୁ  ଆସି ଥି ଲେ ।
ସେତେବେଳକୁ  ଟଲଷ୍ଟୟ ସବୁ  ଦାନ ଦେଇ ଖାଲି  ହୋଇ ଯାଇଥାନ୍ତି । ପଛରେ ଆସି ଥ‌ି ବା ବ୍ୟକ୍ତି ଙ୍କୁ  ଦେଖି  ଗଳାରେ ଲଗାଇ ଆଲି ଙ୍ଗନ କରି  କହି ଥି ଲେ- ଭାଇ! ଏବେ ତୁ ମକୁ  ଦେବାକୁ  ମୋ ନି କଟରେ କି ଛି
ବଞ୍ଚି  ନାହିଁ (ବଳକା ନାହିଁ) । କାଲି  ଆସି ଲେ ନି ଶ୍ଚୟ ତୁ ମ ପାଇଁ  କି ଛି  ରଖି ଥି ବି  । ତାଙ୍କଠାରୁ  ଏଭଳି  ଶୁ ଣି  ଯାଚକ କହି ଥି ଲେ- ‘ଆପଣ ଏଭଳି  କହନ୍ତୁ ନାହିଁ ମହାତ୍ମା । ଆପଣ ଆଜି  ଆଜି  ଯାହା ମୋତେ

ଦେଇଛନ୍ତି , ପୂ ର୍ବ ରୁ  ମୋତେ କେହି ବି  କେବେ ତାହା ଦେଇ ନଥି ଲେ । ଧନ ଦାନକାରୀ ତ ଅନେକ ମି ଳି ବେ, ମି ଳି ବେ, ହେଲେ ହେ ଏଭଳି  ପ୍ରେ ମ, ଆଦର ଦାନକାରୀ ଜଣେ ବି  ମି ଳି ବେ ନାହିଁ । ଅନନ୍ୟ
ପ୍ରେ ମ- ସମ୍ବେଦନ କେବଳ ଆପଣ ହିଁ ଦେଇଛନ୍ତି  ଯାହା ମୋ ଭଳି  ନିଃ ସ୍ଵ ପାଇଁ  ମହାର୍ଘ  ସମ୍ପଦ।'

ଅନୁ ଚ୍ଛେଦଟି ର ସ୍ଵର ଚି ହ୍ନଟ କର ?

A.  ହାସ୍ୟମୟ

B.  ପ୍ରେ ରଣାଦାୟୀ ଓ ଶି କ୍ଷାପ୍ର ଦ

C.  ଆଲୋଚନାମୂ ଳକ

D.  ବ୍ୟଙ୍ଗାତ୍ମକ

✓

Q65 Odia
‘ଜଟି ଳ’ ଶବ୍ଦର ବି ପରୀତ ଶବ୍ଦଟି  କ'ଣ?

A.  କଠି ନ

B.  ସରଳ

C.  ଗୁ ରୁ ତର

D.  ଅସ୍ପଷ୍ଟ

✓

Q66 Odia
‘ସମ୍ବେଦନଶୀଳ’ ଶବ୍ଦଟି  କେଉଁ  ବ୍ୟକ୍ତି ଙ୍କୁ  ବୁ ଝାଏ?

A.  ଯେଉଁ  ବ୍ୟକ୍ତି  ଅନ୍ୟଙ୍କୁ  କଷ୍ଟ ଦେଇଥାଏ

B.  ଯେଉଁ  ବ୍ୟକ୍ତି  ଅନ୍ୟର ଦୁଃ ଖ ବୁ ଝି  ସହାନୁ ଭୂ ତି  ଦେଖାଏ

C.  ଯେଉଁ  ବ୍ୟକ୍ତି  ସବୁ କି ଛି କୁ  ଅବହେଳା କରେ

D.  ଯେଉଁ  ବ୍ୟକ୍ତି  ସଦା କ୍ରୋ ଧି ତ ରହେ

✓

Q67 Odia
ଅନୁ ଚ୍ଛେଦର ମୁ ଖ୍ୟ ବି ଷୟବସ୍ତୁକୁ  ଚି ହ୍ନଟ କର ।

A.  ଧର୍ମ ର ଜଟି ଳତା

B.  ଦାନର ପ୍ର କାର

C.  ସମ୍ବେଦନଶୀଳ ବ୍ୟକ୍ତି ତ୍ଵ

D.  ଯାଚକମାନଙ୍କ ଜୀବନ

https://play.google.com/store/apps/details?id=in.qmaths.blackbook&referrer=src%3Dosssc_cre25
https://rank.qmaths.in


✓

Q68 Odia
ଏହି  ଅନୁ ଛେଦର ଗଢଣ ଚି ହ୍ନଟ କର ?

A.  ବର୍ଣ୍ଣ ନାତ୍ମକ

B.  କାହାଣୀମୂ ଳକ

C.  ପରୀକ୍ଷାମୂ ଳକ

D.  ବି ଶ୍ଳେଷଣାତ୍ମକ

✓

Q69 Odia
"ଖୋଳ ପର୍ବ ତ ମାର ମୂ ଷା"- ଏହି  ଲୋକୋକ୍ତି ର ଠି କ୍  ଅର୍ଥ  କଣ ?

A.  ବଡ କାମ ପାଇଁ  ଅଳ୍ପ ପରି ଶ୍ର ମ କରି ବା ।

B.  ସାମାନ୍ୟ କାର୍ଯ୍ୟ  ପାଇଁ  କଠି ନ ପରି ଶ୍ର ମ କରି ବା ।

C.  କଷ୍ଟ କରି ଲେ ବଡ ଫଳ ମି ଳେ ।

D.  କାମ ନକରି  ବସି  ରହି ବା ।

✓

Q70 Odia
ନି ମ୍ନ ଲି ଖି ତ ମଧ୍ୟରୁ  ତଦ୍ଭବ ଶଦ୍ଦ କେଉଁ ଟି  ?

A.  ଯବ

B.  ଜନ୍ଦା

C.  ଯଅ

D.  ଜନ୍ତାଳ

✓

Q71 Odia
ବର୍ଷା ରେ ପାଣି  ଟୋପାଟୋପା ପଡୁ ଛି ।ଏହି  ବାକ୍ୟରେ ଥି ବା କ୍ରି  ୟାବି ଶେଷଣ ପଦଟି କୁ  ଚି ହ୍ନଟ କର।

A.  ବର୍ଷା ରେ

B.  ଟୋପାଟୋପା

C.  ପାଣି

D.  ପଡୁ ଛି

✓

Q72 Odia
'ସମ୍ଭାବନାସୂ ଚକ ଅବ୍ୟୟ' କାହାକୁ  କୁ ହାଯାଏ ?

A.  ଯେଉଁ  ଅବ୍ୟୟ କାଳକୁ  ବୁ ଝାଏ ।

B.  ଯେଉଁ  ଅବ୍ୟୟ ସମ୍ଭାବନା ପ୍ର କାଶ କରେ ।

C.  ଯେଉଁ  ଅବ୍ୟୟ ସ୍ଥାନକୁ  ବୁ ଝାଏ ।

D.  ଯେଉଁ  ଅବ୍ୟୟ ସମ୍ବୋଧନକୁ  କରେ ।

✓

Q73 Odia
‘ପୋଥି  ବାଇଗଣ' - ରୂ ଢ଼ି ର ଅର୍ଥ  ଲେଖ ।

A.  ପୁ ସ୍ତକ ବହି ର୍ଭୂ ତ ବି ଦ୍ୟା

B.  ପୁ ସ୍ତକଗତ ବି ଦ୍ୟା

C.  ପୋଥି ଗତ ଚି ତ୍ର

D.  ପୋଥି  ପାରି ବା
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✓

Q74 Odia
ଶର୍ମିଷ୍ଠା ଭଲ କହି ପାରେ, --------- ଗାଇପାରେ ନାହିଁ । - ଉପଯୁ କ୍ତ ଅବ୍ୟୟ ପଦଟି  ବାଛି  ଶୂ ନ୍ୟ ସ୍ଥାନ ପୂ ରଣ କର ।

A.  ତେଣୁ

B.  ଯେଉଁ ଥି ପାଇଁ

C.  ମାତ୍ର

D.  ଯଦି

✓

Q75 Odia
ନି ମ୍ନ ଲି ଖି ତ ମଧ୍ୟରୁ  ତଦ୍ଭବ ଶଦ୍ଦ କେଉଁ ଟି  ?

A.  କଫି

B.  ଗି ରଫ

C.  ବାମ୍ଫ

D.  ଚଷମା

Computer

✓

Q76 Computer
MS ପାୱାରପଏଣ୍ଟ 2021 ରେ କେଉଁ  ବି କଳ୍ପ ଆନି ମେସନ୍  ଏବଂ ଟ୍ରା ଞ୍ଜି ସନ୍  ସହି ତ ଫୁ ଲ
ସ୍କ୍ରି ନରେ ପ୍ରେ ଜେଣ୍ଟେସନ ଡି ସପ୍ଲେ  କରେ?

A.  ସ୍ଲା ଇଡ ଶୋ ଭି ଉ

B.  ଡି ଜାଇନ ଭି ଉ

C.  ଭ୍ୟୁ  ପେନ

D.  ସ୍ଲା ଇଡ ସଟର

✓

Q77 Computer
ଜଣେ ବି ଦ୍ୟାର୍ଥୀ  ପାୱାରପଏଣ୍ଟ 2021 ରେ ଏକ ପ୍ରେ ଜେଣ୍ଟେସନ ପ୍ର ସ୍ତୁତ କରୁ ଛନ୍ତି  ଏବଂ ଏକ
ବ୍ଲା ଙ୍କ ଫାଇଲ ସହ ଆରମ୍ଭ କରି ବା ଏବଂ ଏକ ଟେମ୍ପଲେଟ ସହ ଆରମ୍ଭ କରି ବା ମଧ୍ୟରେ
ତୁ ଳନା କରୁ ଛନ୍ତି  । ନି ମ୍ନ ଲି ଖି ତ କେଉଁ  ବି ବୃ ତି ଟି  ସତ୍ୟ କି ମ୍ବା ମି ଥ୍ୟା ଅଟେ?
(i) ଏକ Blank Presentation ଏକ 'Title Slide' ଲେଆଉଟ ସହ ଆରମ୍ଭ ହୋଇଥାଏ
ଏବଂ ୟୁ ଜର ମାଷ୍ଟର ସ୍ଲା ଇଡ ସେଟିଂ ସ ବଦଳାଇବା ପର୍ଯ୍ୟ ନ୍ତ ଅନ୍ୟ କୌଣସି  ପ୍ର କାରର ସ୍ଲା ଇଡ
ଇନସର୍ଟ  କରାଯାଇପାରି ବ ନାହିଁ ।
(ii) ଏକ ଥି ମ୍  ଥି ବା Template କୁ  Design ଟ୍ୟାବ ମାଧ୍ୟମରେ ଯେକୌଣସି  ସମୟରେ
ବଦଳାଯାଇପାରି ବ ଏବଂ ବି ଦ୍ୟାର୍ଥୀ ଙ୍କ ଦ୍ୱାରା ଆଡ କରାଯାଇଥି ବା କଷ୍ଟମ ଇଫେକ୍ଟଗୁ ଡ଼ି କ
(shapes, text boxes) ଅପରି ବର୍ତ୍ତିତ ରହି ଥାଏ ।

A.  (i) ସତ୍ୟ, (ii) ସତ୍ୟ

B.  (i) ସତ୍ୟ, (ii) ମି ଥ୍ୟା

C.  (i) ମି ଥ୍ୟା, (ii) ସତ୍ୟ

D.  (i) ମି ଥ୍ୟା, (ii) ମି ଥ୍ୟା

✓

Q78 Computer
ସି ଲେକ୍ଟ ହୋଇଥି ବା ରୋ ଉପରେ ଏକ ନୂ ତନ ରୋ ଇନସର୍ଟ  କରି ବା ପାଇଁ  ସର୍ଟ କଟ କୀ କ'ଣ
ଅଟେ ?

A.  Ctrl + R

B.  Shift + Delete

C.  Ctrl + Shift + “+”

D.  Alt + Insert

✓

Q79 Computer
ଯେତେବେଳେ ଆପଣ ପ୍ର ଥମ ଥର ପାଇଁ  ପାୱାରପଏଣ୍ଟରେ ଆପଣଙ୍କର ପ୍ରେ ଜେଣ୍ଟେସନ
ସେଭ କରନ୍ତି , ସେତେବେଳେ କେଉଁ  କମାଣ୍ଡଟି  ଉପଯୁ କ୍ତ ହେବ?

A.  File → Save As → format and location ଚୟନ କର

B.  File → Close → Save

C.  Home → Save

D.  View → Save As Template

✓

Q80 Computer
MS ୱାର୍ଡ  2020 ରେ ଫଣ୍ଟ ବା କଲର ଚେଞ୍ଜ ଭଳି  ଏଡି ଟିଂ  କରି ବା ପାଇଁ  ଟେକ୍ସଟ କୁ  ସି ଲେକ୍ଟ
କରି ବା ନି ମନ୍ତେ କେଉଁ  ଫଙ୍କସନ ବ୍ୟବହାର କରାଯାଏ?

A.  Highlighting

B.  Saving

C.  Printing

D.  Closing

https://play.google.com/store/apps/details?id=in.qmaths.blackbook&referrer=src%3Dosssc_cre25
https://rank.qmaths.in


✓

Q81 Computer
ଯେତେବେଳେ ଆପଣ "Reply" କି ମ୍ବା "Reply All" ଅପସନ ବ୍ୟବହାର କରନ୍ତି ,
ସେତେବେଳେ ଆଟାଚମେଣ୍ଟଗୁ ଡ଼ି କର କ'ଣ ହୁ ଏ?

A.  ଆଟାଚମେଣ୍ଟଗୁ ଡି କ ସ୍ଵୟଂଚାଳି ତ ଭାବରେ ଅନ୍ତର୍ଭୁ କ୍ତ ହୁ ଏ

B.  ଆଟାଚମେଣ୍ଟଗୁ ଡ଼ି କ ଅପଡେଟ ହୋଇଥି ବା ଭର୍ଜ ନ ସହି ତ ରି ପ୍ଲେ ସ ହୁ ଏ

C.  ଆଟାଚମେଣ୍ଟଗୁ ଡ଼ି କ ଅନ୍ତର୍ଭୁ କ୍ତ ହୁ ଏ ନାହିଁ

D.  କେବଳ ଇମେଜଗୁ ଡି କ ଅନ୍ତର୍ଭୁ କ୍ତ ହୁ ଏ

✓

Q82 Computer
ଇନଷ୍ଟ୍ରକ୍ସନ ପ୍ର ସେସିଂ  ଏବଂ କାଳକୁ ଲେସନ କରି ବା ପାଇଁ  କେଉଁ  କମ୍ପୋନେଟ ମୁ ଖ୍ୟତଃ ଦାୟୀ?

A.  CPU

B.  ହାର୍ଡ  ଡି ସ୍କ

C.  ମନି ଟର

D.  ମାଉସ

✓

Q83 Computer
କମ୍ପ୍ୟୁ ଟରରେ ଟାସ୍କ ମ୍ୟାନେଜରର କାମ କ'ଣ?

A.  ଏହା ଡି ଭାଇସର ସଫ୍ଟ ୱେର ପ୍ର ୟୋଗ କରି ଥାଏ ।

B.  ଏହା ଡି ଭାଇସରେ ଥି ବା ଡାଟାର ପ୍ରି  ଣ୍ଟିଂ  କାମ କରି ଥାଏ ।

C.  ଏହା ଡି ଭାଇସ ପାଇଁ  ଥି ବା ହାର୍ଡ ୱେରକୁ  କାର୍ଯ୍ୟ କାରୀ କରି ଥାଏ । 

D.  ଏହା ପରଫର୍ମା ନ୍ସ କୁ  ଅପ୍ଟି ମାଇଜ କରି ଥାଏ ।

✓

Q84 Computer
MS ୱାର୍ଡ ରେ ପାରାଗ୍ରା ଫ ଭି ତରେ ଥି ବା ଟେକ୍ସଟର ଆଲାଇନମେଣ୍ଟ ନି ମନ୍ତେ ସଠି କ ଭ୍ୟାଲୁ
ଚୟନ କର ।
i. ଲେଫ୍ଟ
ii. ରାଇଟ
iii. ଜଷ୍ଟି ଫାଏଡ
iv. ଟପ
v. ବଟମ

A.  i, ii, iii, iv ଓ v

B.  କେବଳ i, ii ଓ iii

C.  କେବଳ i, iii, iv ଓ v

D.  କେବଳ ii, iii, iv ଓ v

✓

Q85 Computer
ଏକ ଟେବୁ ଲରେ ଭର୍ଟିକାଲ ଲୁ କଅପ କରି ବା ପାଇଁ  ନି ମ୍ନ ଲି ଖି ତ କେଉଁ  MS ଏକ୍ସେଲ
ଫଙ୍କସନ ବ୍ୟବହୃ ତ ହୁ ଏ?

A.  HLOOKUP

B.  VLOOKUP 

C.  INDEX

D.  MATCH

✓

Q86 Computer
ଏକ କମ୍ପାନୀକୁ  ଡି ଷ୍ଟ୍ରି ବ୍ୟୁ ସନ ପାଇଁ  ଏକ ପୋର୍ଟେ ବଲ ମି ଡି ୟମରେ ଲାର୍ଜ  ସଫ୍ଟ ୱେୟାର
ଇନଷ୍ଟଲେସନ ଫାଇଲଗୁ ଡି କ ସେଭ କରି ବାକୁ  ପଡି ବ। ନି ମ୍ନ ଲି ଖି ତମଧ୍ୟରୁ  କେଉଁ ଟି  ବ୍ୟବହାର
ହେବାର ସମ୍ଭାବନା ଅଧି କ?

A.  CD

B.  LAN

C.  ASCII

D.  RAM

✓

Q87 Computer
ଲାଟେଷ୍ଟ ଡେସ୍କଟପ ପ୍ରୋ ସେସରଗୁ ଡ଼ି କ ______ ଜେନେରେସନ (ରାପ୍ଟର ଲେକ) ର ପାର୍ଟ
ଅଟେ ।

A.  14th

B.  15th

C.  16th

D.  12th

✓

Q88 Computer
MS ୱାର୍ଡ  2010 ରେ, ଆପଣ ଯେତେବେଳେ ‘Save As’ ରେ କ୍ଲି  କ୍  କରନ୍ତି , ସେତେବେଳେ
କ'ଣ ହୁ ଏ?

A.  ଫାଇଲଟି  କ୍ଳୋଜ ହୋଇଯାଏ

B.  ଫାଇଲଟି  ଡି ଲି ଟ ହୋଇଯାଏ

C.  ଏକ କପି କୁ  ଏକ ନୂ ତନ ନେମ କି ମ୍ବା ଲୋକେସନ ଅଧୀନରେ ସେଭ କରେ

D.  ଫାଇଲଟି କୁ  ସେଭ ଓ ପ୍ରି  ଣ୍ଟ କରେ

✓

Q89 Computer
କେଉଁ  ଜରୁ ରୀ କ୍ୟାରେକ୍ଟର ଇମେଲ ଠି କଣାରେ ଥି ବା ଡୋମେନରୁ  ୟୁ ଜରନେମକୁ  ପୃ ଥକ
କରେ?

A.  # ଚି ହ୍ନ

B.  $ ଚି ହ୍ନ

C.  ଚି ହ୍ନ

D.  @ ଚି ହ୍ନ

✓

Q90 Computer
ଏକ ନୂ ଆ ସ୍ପ୍ରେଡସି ଟ ଡକ୍ୟୁ ମେଣ୍ଟରେ କୌଣସି  କାଲକୁ ଲେସନ କରି ବା ପୂ ର୍ବ ରୁ  କେଉଁ
କାର୍ଯ୍ୟ ଟି  ସବୁ ଠାରୁ  ଅଧି କ ଆବଶ୍ୟକ ହେବ?

A.  ସମସ୍ତ ପୂ ର୍ବ  ଡକ୍ୟୁ ମେଣ୍ଟଗୁ ଡି କୁ  ବନ୍ଦ କରି ବା

B.  ଏକ ନୂ ଆ ୱାର୍କ ବୁ କ ଓପନ କରି ବା

C.  ସି ଷ୍ଟମ ଲଗ ଆଉଟ କରି ବା

D.  ଆଣ୍ଟି ଭାଇରସ ସଫ୍ଟ ୱେର ରନ କରି ବା
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Reasoning

✓

Q91 Reasoning
ଏକ ନି ର୍ଦ୍ଦିଷ୍ଟ କୋଡ୍  ଭାଷାରେ,

'A + B' ର ଅର୍ଥ  ' B ର ସ୍ତ୍ରୀ' A ଅଟେ'
'A – B' ର ଅର୍ଥ  ' B ର ଭାଇ A ଅଟେ'
'A × B' ର ଅର୍ଥ  ' B ର ମାଆ A ଅଟେ'
'A = B' ର ଅର୍ଥ  ' B ର ବାପା A ଅଟେ'
ଯଦି  ‘P + R – Y = S x Q’ ହୁ ଏ, ତେବେ P ସମ୍ପର୍କ ରେ Q ଙ୍କର କ'ଣ ହେବେ?

A.  ମାଆଙ୍କ ବାପାଙ୍କ ଭାଇଙ୍କ ସ୍ତ୍ରୀ

B.  ମାଆଙ୍କ ମାଆ

C.  ଭଉଣୀ

D.  ସ୍ତ୍ରୀ'

✓

Q92 Reasoning
ସାତ ଜଣ ବ୍ୟକ୍ତି  - H, I, J, K, L, M ଏବଂ N - ଉତ୍ତର ଦି ଗକୁ  ମୁ ହଁ  କରି  ଏକ ସଳଖ ଧାଡି ରେ
ବସି ଛନ୍ତି  । ଧାଡି ର ଡାହାଣ ପ୍ରା ନ୍ତ ଚତୁ ର୍ଥ  ସ୍ଥାନରେ H ବସି ଛନ୍ତି  । H ଓ K ଙ୍କ ମଧ୍ୟରେ କେବଳ
ଦୁ ଇଜଣ ବ୍ୟକ୍ତି  ବସି ଛନ୍ତି  । H ଙ୍କ ଡାହାଣ ପାର୍ଶ୍ୱ  ତୃ ତୀୟ ସ୍ଥାନରେ I ବସି ଛନ୍ତି  । K ଙ୍କ ଡାହାଣ
ପାର୍ଶ୍ୱ  ଚତୁ ର୍ଥ  ସ୍ଥାନରେ M ବସି ଛନ୍ତି  । K ଏବଂ N ଙ୍କ ମଧ୍ୟରେ କେବଳ L ବସି ଛନ୍ତି  । ଧାଡି ର
ଡାହାଣ ପ୍ରା ନ୍ତରୁ  ଦ୍ୱି ତୀୟ ସ୍ଥାନରେ କି ଏ ବସି ଛନ୍ତି ?

A.  L

B.  M

C.  J

D.  N

✓

Q93 Reasoning
ଗୋଟି ଏ କୋଠାର ଛଅଟି  ଭି ନ୍ନ ମହଲାରେ G, H, I, J, K ଓ L ରୁ ହନ୍ତି  । କୋଠାର ସବୁ ଠାରୁ
ତଳ ମହଲାକୁ  ନମ୍ବର 1, ଏହାର ଉପର ମହଲାକୁ  ନମ୍ବର 2 ଏବଂ ଏହି ପରି  ଭାବରେ ସବୁ ଠାରୁ
ଉପର ମହଲାକୁ  ନମ୍ବର 6 ଦି ଆଯାଇଛି  ।
G ଓ J ରହୁ ଥି ବା ମହଲାର ଗୁ ଣଫୁ ଳ 15 ଅଟେ । K ଙ୍କ ଠି କ ଉପରେ L ରୁ ହନ୍ତି  । H ଓ J
ରହୁ ଥି ବା ମହଲାର ସମଷ୍ଟି  7 ଅଟେ । K ତଳେ କେତେ ଜଣ ଲୋକ ରୁ ହନ୍ତି ?

A.  0

B.  2

C.  3

D.  4

✓

Q94 Reasoning
ଯଦି  + ର ଅର୍ଥ  −, − ର ଅର୍ଥ  ×, × ର ଅର୍ଥ  ÷, ଏବଂ ÷ ର ଅର୍ଥ  + ହୁ ଏ, ତେବେ ନି ମ୍ନ ଲି ଖି ତ
ସମୀକରଣରେ ପ୍ର ଶ୍ନ  ଚି ହ୍ନ (?) ସ୍ଥାନରେ କ'ଣ ହେବ?

14 − 4 ÷ 55 + 99 × 11 = ?

A.  102

B.  113

C.  149

D.  176

✓

Q95 Reasoning
ଏକ ନି ର୍ଦ୍ଦିଷ୍ଟ କୋଡ୍  ଭାଷାରେ 'HATS' କୁ  '4361' ଭାବରେ ଏବଂ 'THIS' କୁ  '6139'
ଭାବରେ କୋଡ୍  କରାଯାଇଛି  । ପ୍ର ଦତ୍ତ କୋଡ୍  ଭାଷାରେ 'I' ପାଇଁ  କୋଡ୍  କ'ଣ ହେବ?

A.  6

B.  1

C.  3

D.  9

✓

Q96 Reasoning
ନି ମ୍ନ ରେ ପ୍ର ଦତ୍ତ ଦୁ ଇଟି  ଯୋଡ଼ି  ସେଟ ଯେଉଁ  ଢାଞ୍ଚା ଅନୁ ସରଣ କରନ୍ତି , ସେହି  ସମାନ ଢାଞ୍ଚା
ଅନୁ ସରଣ କରୁ ଥି ବା ଯୋଡି  ଚୟନ କରନ୍ତୁ । ଉଭୟ ଯୋଡି  ସମାନ ଢାଞ୍ଚା ଅନୁ ସରଣ କରନ୍ତି  ।
ONM : QPJ
KJG : MLD

A.  TML : VOH

B.  PRE : RSB

C.  QEJ : SGF

D.  JQX : LSU

✓

Q97 Reasoning
ପ୍ର ଦତ୍ତ ଅନୁ କ୍ର ମକୁ  ତର୍କ ସି ଦ୍ଧ ଭାବେ ସଂପୂ ର୍ଣ୍ଣ  କରି ବା ପାଇଁ  ନି ମ୍ନ ଲି ଖି ତ ବି କଳ୍ପଗୁ ଡି କ ମଧ୍ୟରୁ
କେଉଁ ଟି କୁ  ପ୍ର ଶ୍ନ ଚି ହ୍ନ (?) ସ୍ଥାନରେ ସ୍ଥାପି ତ କରାଯାଇପାରି ବ?

ZWZY WTWV ? QNQP NKNM

A.  NOQP

B.  TQTS

C.  NLML

D.  NJML

✓

Q98 Reasoning
ପ୍ର ଦତ୍ତ ବି ବୃ ତି  ଓ ନି ଷ୍କର୍ଷ ଗୁ ଡି କୁ  ଧ୍ୟାନର ସହି ତ ଅଧୟନ କରନ୍ତୁ । ଏହା ସାଧାରଣତଃ
ଜଣାଶୁ ଣା ତଥ୍ୟ ଠାରୁ  ଭି ନ୍ନ ମନେହେଲେ ସୁ ଦ୍ଧା ବି ବୃ ତି ରେ ପ୍ର ଦତ୍ତ ତଥ୍ୟ କୁ  ସତ୍ୟ ବୋଲି
ବି ବେଚନା କରନ୍ତୁ ଏବଂ ପ୍ର ଦତ୍ତ ବି ବୃ ତି  (ଗୁ ଡି କୁ ) କୁ  ତର୍କ ସଙ୍ଗତ ଭାବରେ କେଉଁ  ନି ଷ୍କର୍ଷ
(ଗୁ ଡି କ) ଅନୁ ସରଣ କରୁ ଛି  ତାହା ନି ର୍ଣ୍ଣ ୟ କରନ୍ତୁ ।
ବି ବୃ ତି : କି ଛି  ଜାଜ ନୀଳ ଅଟେ । ସମସ୍ତ ନୀଳ ଶି ଳା ଅଟେ ।
ନି ଷ୍କର୍ଷ  I: ସମସ୍ତ ଜାଜ ଶି ଳା ଅଟେ ।
ନି ଷ୍କର୍ଷ  II: କି ଛି  ଶି ଳା ଜାଜ ଅଟେ ।

A.  କେବଳ ନି ଷ୍କର୍ଷ  (I) ଅନୁ ସରଣ କରେ

B.  କେବଳ ନି ଷ୍କର୍ଷ  (II) ଅନୁ ସରଣ କରେ

C.  ନି ଷ୍କର୍ଷ  (I) କି ମ୍ବା (II) କୌଣସି ଟି  ଅନୁ ସରଣ କରେ ନାହିଁ

D.  ଉଭୟ ନି ଷ୍କର୍ଷ  (I) ଏବଂ (II) ଅନୁ ସରଣ କରେ
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✓

Q99 Reasoning
ଇଂରାଜୀ ବର୍ଣ୍ଣ ମାଳା କ୍ର ମ ଆଧାରରେ ନି ମ୍ନ ଲି ଖି ତ ଚାରୋଟି  ଅକ୍ଷର-ପୁ ଞ୍ଜ ଯୋଡ଼ି  ମଧ୍ୟରୁ
ତି ନୋଟି  ଏକ ନି ର୍ଦ୍ଦିଷ୍ଟ ଉପାୟରେ ସଦୃ ଶ ଅଟନ୍ତି  ତେଣୁ  ଏହି ପରି  ଏକ ଗୋଷ୍ଠୀ ଗଠନ କରନ୍ତି
। କେଉଁ ଟି  ସେହି  ଗୋଷ୍ଠୀର ଅନ୍ତର୍ଭୁ କ୍ତ ନୁ ହେଁ ?
(ଦ୍ର ଷ୍ଟବ୍ୟ: ଅସାମଞ୍ଜସ୍ୟଟି  ବ୍ୟଞ୍ଜନବର୍ଣ୍ଣ /ସ୍ୱରବର୍ଣ୍ଣ  ସଂଖ୍ୟା କି ମ୍ବା ଅକ୍ଷର ପୁ ଞ୍ଜରେ ସେମାନଙ୍କର
ସ୍ଥି ତି  ଉପରେ ଆଧାରି ତ ନୁ ହେଁ )

A.  MO-PS

B.  LN-OQ

C.  AC-DF

D.  JL-MO

✓

Q100 Reasoning
ନି ମ୍ନ ଲି ଖି ତ ଅକ୍ଷର ଅନୁ କ୍ର ମ ଆଧାରରେ ପ୍ର ଶ୍ନ ର ଉତ୍ତର ଦି ଅନ୍ତୁ ।
(ବାମ) P L O K I J U H Y G T F R D E S W A Q (ଡାହାଣ)
ଅନୁ କ୍ର ମର ବାମ ପ୍ରା ନ୍ତରୁ  ତୃ ତୀୟ ଅକ୍ଷର ଏବଂ ଡାହାଣ ପ୍ରା ନ୍ତରୁ  ଚତୁ ର୍ଥ  ଅକ୍ଷର ମଧ୍ୟରେ
ଇଂରାଜୀ ବର୍ଣ୍ଣ ମାଳା କ୍ର ମ ଆଧାରରେ କେତୋଟି  ଅକ୍ଷର ଅଛି ?

A.  ତି ନି

B.  ପାଞ୍ଚ

C.  ଚାରି

D.  ଛଅ
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